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PREFACE About This Guide
This preface describes the following:
Intended Audience on page ix
Where to Find Additional Information on page x

Intended Audience
This document assumes you have a basic understanding of the following:

Networking
Storage Area Networks (SANs)
The Common Information Model (CIM)

To learn more about:
CIM - See www.snia.org and www.dmtf.org.

www.snia.org
www.dmtf.org


x

Where to Find Additional Information
The software also ships with the following documentation:

The documentation listed above, except for the help system, can be found in two locations:
On the CD-ROM used to install the CIM Extensions.
From the online help system accessible by clicking the Help menu in the management 
server.

Table 1-1: Additional Documentation

Document Description
Release Notes Provides late-breaking issues that 

might impact the usage of the product.
Installation Guide Provides information on how to 

configure the management server and 
install the CIM Extensions

User Guide Describes how to use the 
management server. The information 
in this guide is also accessible from 
the online help.

Online help An online help system containing 
information from the following 
documents:

User Guide
File Servers Guide
CLI Guide
Guide for monitoring 
applications

CLI Guide Provides information about the CLI 
commands. 

Guide for monitoring applications Describes how to use the 
management server to monitor 
applications.



CHAPTER 1 Overview of File Server 
SRM
Your business is only as good as your storage infrastructure. You depend on data for the core 
functions of your business. The growth of your business or just maintaining day-to-day business 
activities adds even more data. The challenge is in knowing if your file storage infrastructure is 
growing in a managed, organized and efficient manner. Given the sheer volumes of data, obtaining 
this sort of information can be difficult. 

With the industry’s most versatile scanner which creates an information store about your storage 
system, the management software for file systems has been designed to scale to the needs of 
enterprise file systems.

Also, by combining file, logical and physical storage resource monitoring and reporting with active 
SAN management, this software provides a single integrated system for managing your entire file 
storage infrastructure.

It provides detailed analysis of your file storage in four key areas:
Composition – Aging, Size

Why are there files on a system that have not been accessed for more than six 
months?
What is the size group distribution on various file systems?
Do we need hierarchical storage management or a store and delete policy?

Content – Extensions
Are file systems being used properly?
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Is there misuse of storage space?
If it is, then who are the offenders?

Consumer - Users, Ownership, Applications
Who is using how much space?
Is the usage planned?

Capacity - Used and Available
What is the total available capacity?
How much is being used?

File Server SRM does a recursive lookup on the file system and stores the information in an 
embedded database. File Server SRM can scan files very quickly for several reasons because File 
Server SRM never opens the files. 

Keep in mind the following:
If you do not see information for the file server, verify the collector for the file server is 
running. You can verify the collector is running by clicking  or Configuration > FSRM. On 
the Data Collection tab, look in the Running? column. See the topic, “Managing Collectors 
for File Server SRM“in the User Guide for more information.
Depending on your license, File Server SRM may not be available. See the “List of 
Features” to determine if you have access to File Server SRM. The “List of Features” is 
accessible from the Documentation Center (Help > Documentation Center). 
If you plan to have File Server SRM scan a host, make sure you have 80-120 MB for each 
set of 1 million files. The actual size is dependent on the length of the file names.
If you want to use File Server SRM bulk import capability for non-ASCII characters (such 
as Chinese, Japanese, or Korean), the file should be created with UTF-8 encoding. 
Notepad, among other tools, lets you specify the encoding in its “Save As” dialog.

Reparse points (Junctions) for file servers on Microsoft Windows are scanned. For 
example, assume you create a “junction” named C:\DDrive, which points to the root of the 
D drive. The content of the D drive is available under C:\DDrive. After a scan, information 
on capacity and amount used are displayed for the C drive; however, the sum of the file 
sizes on the C drive also includes the junction (C:\DDrive), which points to the root of the D 
drive. If you do not want to include the scanning of reparse points, see “Disabling the 
Scanning of Reparse Points” on page 6. Reparse points created using the Windows Disk 
Management tool are discovered as a drive that can be scanned independently.
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About Reports for File Server SRM
Reporter provides a variety of detailed reports for file servers. You can view reports for File Server 
SRM in Reporter by clicking System > File Server in Reporter. To access Reporter, click Reporter.

Data collectors gather information for reports. If you stop a data collector, its reports are not updated. 
You might want to verify a collector is running if you are having difficulty viewing a report or you 
believe the report is not displaying the latest information. See the User Guide for more information.

The management server provides reports that display performance information in a variety of 
formats:

HTML (Default) - The software displays the report in a Web page by default.
PDF - The software displays the report in Adobe Acrobat, a good option if you need to print 
the report. The software assumes you already have Adobe Acrobat Reader installed on 
your computer. To obtain a copy of Adobe Acrobat Reader, go to http://www.adobe.com.
Excel - The software displays the report in Microsoft Excel, providing you have a copy of 
Microsoft Excel already installed.
XML - The software displays the report in the XML format.

It also provides some reports with pie charts. The  icon next to the report name indicates the report 
displays a graphic. 

Note: Non-ANSI text—for example Asian characters and the Euro symbol—included in a CSV file, 
is not displayed properly by Microsoft Excel. Excel replaces the non-ANSI text with a 
question mark (?). 

Policies for File Server SRM
This chapter describes the following:

Accessing Policy Manager for File Server SRM on page 4
Creating Policies for File Server SRM on page 4

http://www.adobe.com
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Accessing Policy Manager for File Server SRM
This topic provides the various techniques for accessing Policy Manager. You have multiple options 
for accessing utilization policies for file servers. The flexibility for accessing utilization policies lets 
you easily create and manage utilization policies without interrupting your work flow. 

Policy Manager provides the following options for accessing utilization policies: 
To easily access other functionality, such as the Events, Topology and Volumes tabs 
- Double-click a file server in System Explorer and then click the Policies tab. This method 
displays the utilization policies for just the file server that was double-clicked. 
To easily access all utilization policies - Click Policy Manager. In the Policy Manager 
tree in the middle pane, expand the node, Utilization Policies. Then, expand the 
Applications and File Servers nodes for the file server. Click the name of the file server 
for which you want to create a policy. To view all utilization policies, click the Utilization 
Policies node.
To easily access other functionality for file servers - Access the Policy tab in 
Application Explorer. Expand the Applications and File Servers nodes in the tree in 
Application Explorer. Click the file server name in the Application Explorer tree. Click the 
Policies tab in the right pane.

Creating Policies for File Server SRM
You can create a utilization policy that generates an event, sends an e-mail, or runs a custom 
command when an element is being overused. For example, you can configure Policy Manager so 
you receive an e-mail message when the amount of free space on a server decreases to a specified 
level.

Important: If you plan to use e-mail notification with your policy, first assign an SMTP server from 
which the management server can send its e-mail notifications. See the topic, "Setting 
Up E-mail Notification."

To create a utilization policy for a file server:
1. Access Policy Manager as described in the topic,“Accessing Policy Manager for File 

Server SRM” on page 4.
2. In the right pane, click the Add button.
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3. Select a policy. Then, click Next. 
The following types may be displayed.

4. In the Name field on the Policy Properties tab, modify the name of the policy or keep the 
default.

5. In the Description field, modify the description for the policy or keep the default.
6. In the Re-arm Period field, specify a re-arm period in minutes.

The rearm period is the amount of time after the policy executes before it can execute 
again. It is useful for limiting the number of times the same actions will execute. 

Important: Specify shorter periods for important applications.

7. To the right of the comparison operator drop-down menu, type a percentage or an amount 
in gigabytes (GB) depending on the field name displayed. 

8. For trending policies, enter the number of days in the Historic period field 
(min=7; max=180) and Projection period field (min=1; max=180).

9. Select an action to occur when the policy condition is fulfilled by clicking one of the 
following buttons (more than one action can be assigned to a policy):

Send E-mail - Policy Manager sends an e-mail when the condition is fulfilled. Enter a 
comma-separated list of e-mail addresses, and then click OK. 
Generate Event - Policy Manager generates an event of the specified event type. The 
event appears in Event Manager. Select one of the following event types.
Important: Since the severity level for an element is set by the manufacturer, the 
meanings of the severity levels vary. It is best to view the description of the event. 

Unknown - The severity level is not known. 
Informational - An example of an informational event is a progress report event 
for firmware download operation currently in progress.

Table 1-1: Policy Templates

Policy Type Description
Free Space Amount of free space on the file server.
Percent Used Percentage of disk space used. 
Free Space Trending Free space trending for File Server SRM.
Trending for Percent Used Trending for percent of storage used for File Server SRM
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Warning - An example of a warning is one or more new physical fabric objects 
(device port, switch, or fabric) have appeared.
Minor - An example of a minor event is a physical fabric object (switch port or 
fabric) has changed state.
Major - An example of a major event is one or more physical fabric objects 
(device port, switch, or fabric) have disappeared.
Critical - An example of a critical event is Brocade switches that have a failed 
firmware download and the failure reason code for each respective switch.

After you select an event level, click OK. 

Execute a Custom Command - Policy Manager executes a custom command on the 
management server when the condition is fulfilled. Type a command that will execute 
the script in the field. Then, click OK. The software assumes you are in the 
[Install_Dir]\JBossandJetty\server\appiq\remotescripts directory 
on the management server when the script is executed. You can use environment 
variables in your script, such as POLICY_NAME and POLICY_DESCRIPTION. 
POLICY_NAME. POLICY_NAME provides the policy name and 
POLICY_DESCRIPTION provides the policy description. See the topic, "Software 
Environment Variables for Scripting" in the User Guide for more information.
Prefix the command with "start" if the custom command triggers a UI component, such 
as a program that uses the UI (Example: Microsoft Internet Explorer) or a command 
prompt window.

For example, assume you want the custom command to open a command prompt 
window and list the contents in the directory. You would prefix the command with start 
as shown below:

start dir
10. Click Finish.
11. To test a policy, click the Test button in the Utilization Policy table.
12. For more information about editing, deleting and e-mailing policies, see the chapter on 

Policy Manager in the User Guide.

Disabling the Scanning of Reparse Points
Reparse points (Junctions) for file servers on Microsoft Windows are scanned. For example, 
assume you create a "junction" named C:\DDrive, which points to the root of the D drive. The 
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content of the D drive is available under C:\DDrive. After a scan, information on capacity and 
amount used are displayed for the C drive; however, the sum of the file sizes on the C drive also 
includes the junction (C:\DDrive), which points to the root of the D drive. 

To disable the scanning of reparse points on Windows file servers:
1. Click Configuration > Product Health. Then, click Advanced in the Disk Space tree.
2. Click Show Default Properties at the bottom of the page.
3. Copy the fileSrm.disableReparsePointsScan property. How you copy the text 

depends on your Web browser. If you are using Microsoft Explorer or Netscape Navigator, 
select the text and then right-click the selected text. Then, select Copy.

4. Return to the Advanced page (Configuration > Product Health. Then, click Advanced in 
the Disk Space tree).

5. Paste the copied text into the Custom Properties field. How you paste the text depends 
on your Web browser. If you are using Microsoft Explorer or Netscape Navigator, right-click 
the field and select Paste. 

6. Change the value assigned to the fileSrm.disableReparsePointsScan property to 
true in the Custom Properties field. 
fileSrm.disableReparsePointsScan=true

7. When you are done, click Save.
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CHAPTER 2 File Server Details
This chapter describes the following:
Viewing Summary Information About File Servers on page 9
Types of Files on the File Servers on page 10
Age Properties of Files on File Servers on page 12
Viewing Security and User Identifiers for All File Servers on page 14
Viewing Size Group Distribution Information on page 17
Managing Users on page 19

Viewing Summary Information About File 
Servers
The management server provides a page that displays the summary information about all the file 
servers. To access the Summary page expand the Applications node in the tree in Application 
Explorer. Then, click File Servers node. The Summary page is displayed by default. It provides a 
snapshot of the applications the management server detects by displaying the following:
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A graph displaying the top five file servers by usage and the amount of space they occupy.
A summary table to the right of the graph displaying the number of:

Total File Servers
Total Volumes
Total Capacity
Used Space
Free Space
Percent Used Space
Percent Free Space
Total Users
Total Users Space

A table under the graph displaying the following for each file server:
File Server name
Total Volumes
Capacity
Used 
Percentage Used
Number of Users
User Space

Types of Files on the File Servers
The Extensions page provides information about the types of files on the file servers. For example, it 
can let you know how many mpg files are stored on the file servers and their file size. 

To access the Extension page:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click File Servers node.
4. Click the Extensions tab in the right pane. 

You see the following:

A graph displaying the top 10 extensions and their size. 
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A table below the graph displaying the extensions and the following properties:
Size - The size of all the files with that extension. This property lets you see 
which types of files are using the most space on the file servers.
Count - The number of files with this extension.

5. To filter extensions, type the extension name and click the Submit button.
6. In the right pane, click an extension under the Extension column.

The following is displayed:

A pie chart showing the sizes of the files with the extension per server.
A pie chart showing the number of files with the extension per server.
A table showing the number of files with the extension per server, the amount of space 
they occupy, and the collection time.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all 
data points are less than 1 MB.

7. To view more information about the extensions on a volume, click a file server in the File 
Server column in the table.
The following is displayed:

A pie chart showing the sizes of the files with the extension per volume
A pie chart showing the number of files with the extension per volume
A table showing the number of files with the extension per volume and the amount of 
space they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all 
data points are less than 1 MB.

8. To view a listing of the largest N and oldest N files with the extension on the volume, click a 
volume in the Drive column in the table. The value of N is governed by the property 
fileSrm.countForFSRMDrilldowns, which has a default value of 25 and is configurable in 
the range 10 to 100.

Note: You can save the files with the extension for a volume in a comma-separated list 
(CSV file) by clicking the Save Extension Detail button in the right pane. 

Filtering Files

Filters use the following expressions:
d* will return all extensions starting with d 
*d will return all extensions ending with d 
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*d* will return all extensions having d in the extension

You can enter a list of extensions separated by a comma. 

Age Properties of Files on File Servers
The Aging page provides information about the age of the files on the file servers. It is accessible by 
doing the following:

1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click File Servers node.
4. Click the Aging tab in the right pane. 
5. To save the aging details to a comma-separated list (CSV file):

a. In the right pane under the File Server column on the Aging tab, click a link for a file 
server.

b. Click a link for a volume in the right pane.
c. Click one of the following headings in the right pane:

0-30 days
30-60 days
60-90 days
90-180 days
180+ days

d. Click the Save Aging Details button. 

By default the page displays the following information about the last time a file was accessed. 
A graph displaying the size of each set of files belonging to an age group: 

30 - Files accessed in the last 30 days
60 - Files accessed within 30 and 60 days
90 - Files accessed within 60 and 90 days
180 - Files accessed within 90 and 180 days
180+ - Files accessed more than 180 days ago.

A graph displaying the number of files belonging to an age group:



Age Properties of Files on File Servers                       13
30 - Files accessed in the last 30 days
60 - Files accessed within 30 and 60 days
90 - Files accessed within 60 and 90 days
180 - Files accessed within 90 and 180 days
180+ - Files accessed more than 180 days ago. 

Age Distribution combo box. You can change this page to display information according 
to when the files were last modified or created. Select one of the options and click Submit.
A table under the graph displaying the number of files accessed within the specified time 
period and the size of those files.

Viewing Individual Files
To view a listing of files with a particular age attribute, do the following:

1. Click the one of the following headings in the table on the Age tab for the file servers.
0-30 days
30-60 days
60-90 days
90-180 days

The following is displayed:

A pie-chart showing the size of the files that fit the criteria. They are color coded by 
server.
A pie-chart showing the number of files that fit the criteria. They are color coded by 
server.
A table listing the file servers and the size of files and number of files fitting the criteria.

2. Click a file server in the File Server column.
The volumes on the file server are listed. 

3. Click a volume. The largest N files that meet the criteria are listed. The value of N is 
governed by the property fileSrm.countForFSRMDrilldowns, which has a default value of 
25 and is configurable in the range 10 to 100.

4. To save the aging details to a comma-separated list (CSV file), click the Save Aging 
Details button. 
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Viewing Security and User Identifiers for 
All File Servers
You can get owner related details by accessing the Ownership tab. This tab also lets you determine 
how many files this owner is using on file server.

Important: The Ownership tab is disabled by default for file servers running on Microsoft Windows. 
To view the Ownership tab, you must set the fileSrm.collectWindowsSID property 
to true as described in “Enabling the Ownership Tab on Windows” on page 16, or you 
can select the Collect Ownership Information checkbox when configuring a file server 
scan.

The Ownership tab is accessible by doing the following:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click the File Servers node.
4. Click the Ownership tab in the right pane. 

A graph displaying the top 10 owners, who use the most in megabytes. 
A table displaying the following:

Ownership - The security identifier (Windows) or user identifier (UNIX).
Files - The files that the security identifier or user identifier uses.
Size - The total size of the files the security identifier or user identifier uses.

5. To filter by owner, enter the owner name and click the Submit button
6. To learn more about an owner, click an owner’s name. 

The following is displayed:

A pie chart showing the sizes of the files with the owner per server.
A pie chart showing the number of files with the owner per server.
A table showing the number of files with the owner per server and the amount of 
space they occupy.
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Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty 
graph if all the data points are less than 1 MB.

7. To view more information about the owner on a volume, click a file server in the File Server 
column in the table. 
The following is displayed:

A pie chart showing the sizes of the files with the owner per volume
A pie chart showing the number of files with the owner per volume
A table showing the number of files with the owner per volume and the amount of 
space they occupy.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty 
graph if all the data points are less than 1 MB.

8. To learn more about what is assigned to the owner on a volume, click the volume name.
This page not only displays owner details, but it also lets you save them. See “Saving 
Owner Details” on page 15 and “Saving Owner Details” on page 15. The following tabs are 
provided on this page:

Aging - Aging information of files owned by the owner.
Extensions - The Extension summary of files owned by the owner.
Sizes - The size group information of the files assigned to the owner.
Largest Files - List of N largest files assigned to the owner.
Aged Files - The list of N most aged files by access assigned to the owner.

Note: Clicking on the hyperlinks provided in each of these tabs allows the download of a 
CSV file that lists the files that match the criteria.

Saving Owner Details
The management server lets you save owner details for a volume to a CSV (comma separated 
values) file, which can be opened in Microsoft Excel or in a text editor, such as Notepad. 



File Server Details16
To save owner details:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click the File Servers node.
4. Click the Ownership tab in the right pane. 
5. Click an owner’s name. 
6. Click the file server name.
7. Click the volume name.
8. Click Save Owner Details.

Owner details for a volume are saved to a CSV file. 

Note: Non-ANSI text—for example Asian characters and the Euro symbol—included in a CSV file 
is not displayed properly by Microsoft Excel. Excel replaces the non-ANSI text with a 
question mark (?).

Enabling the Ownership Tab on Windows
The Ownership tab is disabled by default for file servers running on Microsoft Windows. To view the 
Ownership tab, you must set the fileSrm.collectWindowsSID property to true. To set the 
fileSrm.collectWindowsSID property to true:

1. Click Configuration > Product Health then click Advanced in the Disk Space tree.
2. Click Show Default Properties at the bottom of the page.
3. Copy the fileSrm.collectWindowsSID property. How you copy the text depends on 

your Web browser. If you are using Microsoft Explorer or Netscape Navigator, select the 
text and then right-click the selected text. Then, select Copy.

4. Return to the Advanced page (Configuration > Product Health then click Advanced in 
the Disk Space tree).

5. Paste the copied text into the Custom Properties field. How you paste the text depends 
on your Web browser. If you are using Microsoft Explorer or Netscape Navigator, right-click 
the field and select Paste. 

6. Make your changes in the Custom Properties field.
Change the value assigned to the fileSrm.collectWindowsSID property to true. 

fileSrm.collectWindowsSID=true



Viewing Size Group Distribution Information                       17
7. When you are done, click Save.

Viewing Information for Owners on a Volume
1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.

Information about the volume is displayed.

3. Click a link under the Ownership column. 
The following information is displayed for an owner:

Age tab - Displays the number of files and their size that have been accessed, 
modified, and created. 
Extension tab- Lists the file extensions by size and count.
Sizes tab - Lists the files by size.
Aged Files tab - Lists the file and the last date and time it was accessed, modified, or 
created. The date and time are based on the management server. 
Largest files tab - It lists the largest files first by size. The date and time the file was 
last accessed, modified or created is displayed.

The information is saved to a csv (comma separated list) file, which can be viewed in a text 
editor as well as Microsoft Excel. 

The following information is saved in the file:

file name
size
last accessed
last modified
when created

Viewing Size Group Distribution 
Information
The Sizes tab displays size distribution information for file servers.
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To access the Sizes tab:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click the File Servers node.
4. Click the Sizes tab in the right pane. 

The page displays the following:

A bar chart displaying the size group distribution by usage
A bar chart displaying the size group distribution by count
A table listing the number of files and the total size for each size group on each file 
server.

5. Click one of the following headings in the table on the Size tab:
0 Bytes 
0 -10 KB
10 -100 KB
100 -1 MB
1 -10 MB
10 - 100 MB
100 + MB

The following is displayed:

A pie chart showing the sizes of the files with the size group per server.
A pie chart showing the number of files with the size group per server.
A table showing the number of files with the size group per server and the amount of 
space they occupy.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty 
graph if all the data points are less than 1 MB. 

6. To view more information about the size group on a volume, click a file server in the File 
Server column in the table.
The following is displayed:

A pie chart showing the sizes of the files with the size group per volume
A pie chart showing the number of files with the size group per volume
A table showing the number of files with the size group per volume, the amount of 
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space they occupy, and the collection time.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty 
graph if all the data points are less than 1 MB.

7. To view a listing of the oldest N files with the size group on the volume, click a volume in the 
Drive column in the table. The value of N is governed by the property 
fileSrm.countForFSRMDrilldowns, which has a default value of 25 and is configurable in 
the range 10 to 100.

Note: You can save the files with the size group for a volume in a comma-separated list 
(CSV file) by clicking the Save SizeGroup Details button in the right pane.

Managing Users
This section describes the following:

Properties of Users on page 19
Viewing Details for a File Server SRM User on page 21
Adding File Server SRM Users on page 21
Modifying File Server SRM Users on page 23
Deleting File Server SRM Users on page 23
Exporting the List of Users on page 24
Modifying a List of Users on page 25
Importing a List of Users on page 27

Properties of Users
The Users tab displays the properties of the user accounts assigned to file servers. 

It is accessible by doing the following:
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1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click the File Servers node.
4. Click the Users tab in the right pane. 

Important: The users described on this page are different from the users for the management 
server. If you are not seeing data on this page, you must first create your File Server 
SRM users, as described in the topic, “Adding File Server SRM Users” on page 21.

The page displays the following:
A graph displaying the top 5 users by usage and the amount of space they use.
A summary table to the right of the graph displaying the following:

Users - The number of users assigned to all of the file servers monitored.
Users Size - The amount of space the users use. 
Largest User - The user who uses the most space.
Largest User Size - The amount of space the largest user uses. 

A table below the graph displaying the users and the following properties:
*User ID - The ID of the user
*User Name - The name of the user
*Home Directory - The home directory of the user. The home directory is assigned to 
a user by the user’s organization. By default, the user has full access rights (read, 
write, execute) to the home directory. A user can have multiple home directories.
*Owner - The owners who are associated with the user. A user can have multiple 
owners.
Department Number - The number of the department to which the user is assigned. 
The department number was entered when the department was created in 
Chargeback. 
*Quota - The amount of space the user is allocated
Used - The amount of space the user is using
Instances - The number of file servers on which the user's home directory is present.
*These properties and the full name are entered manually. 

To display the properties of just one user account, type the full name in the Filter field and then click 
the Submit button. 
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Viewing Details for a File Server SRM User
You can view detailed information about a File Server SRM user, such as the following:

Department
Quota
Total Used by Owners
Total Used by Directories 

To view details of a File Server SRM user:
1. Access Application Explorer.
2. Expand the File Servers node in the tree in Application Explorer. 
3. In the right pane, click the Users tab.
4. Under the User ID column, click the link for the user you want to know more about.

You are shown detailed information about the user.

Adding File Server SRM Users
File Server SRM provides data about users on the file servers. For example the software provides 
information such as: 

The amount of space the users are using
The user who is using the most amount of space and the amount of space being used 

To obtain information about users, you must first add them in File Server SRM. These users differ 
from the users for the management server. When you add a File Server SRM user, you are making 
File Server SRM aware of that user for monitoring. That user is not granted access to the 
management server. 

Note: If you used File Server SRM in a previous release, you may remember users were created 
for a specific file server. Now users are no longer dependent on a single file server. 

To add a File Server SRM user:
1. Click AppExplorer.
2. Click the File Servers node. 
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Note: Do not click the node name for an actual file server. Click the node with the name 
File Servers.

3. In the right pane, click the Users tab.
4. Click the New User button located under the graph.
5. In the ID field, type the user ID.
6. In the Name field, type the name for the user.
7. In the Directories field, enter the home directory for the user. The home directory is 

assigned to a user by the user’s organization. A user can have multiple home directories. 
Separate additional directories with a comma. 

Note: Directory paths are case sensitive and must be fully qualified paths. Map a user’s 
usage to the home directory when configuring a file server scan.

8. In the Owners field, enter the owners that are associated with the user. Separate multiple 
owners with a comma. The owner names should be similar to what the OS reports. For 
example, the domain\username on Windows.

Note: It is required that information be entered into either the Directories field or the 
Owners field, but not both. Entering information into both fields is accepted, but not 
required. 

9. In the Department No drop-down menu, select a department number corresponding to the 
department to which the user belongs. The department number was assigned to the 
department when the department was added by using Chargeback

10. In the E-mail field, type the user’s e-mail address.
11. In the Quota field, type the maximum amount in megabytes the user can use.

Note: Entering 0 in the Quota field grants unlimited storage capacity to the selected user.

12. Click OK.
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Modifying File Server SRM Users
You can modify the following properties for a File Server SRM user:

Name
Directories
Owners
Department Number
E-mail
Quota

Important: These steps modify a File Server SRM user, not a user account for the management 
server.

To modify one or more of these properties for a user:
1. Click AppExplorer.
2. Click the File Servers node.

Note: Do not click the node name for an actual file server. Click the node with the name 
File Servers.

3. In the right pane, click the Users tab.

4. In the table below the graphic, click the Edit ( ) button corresponding to the user you 
want to modify.

5. Modify one or more of the properties listed at the beginning of this section.
6. Click OK.

The File Server SRM user is updated.

Deleting File Server SRM Users
To delete a File Server SRM user:
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Important: These steps modify a File Server SRM user, not a user account for the management 
server. They do not impact access to the management server nor to the file server. 

To delete a File Server SRM user:
1. Click AppExplorer.
2. Click File Servers node. 

Note: Do not click the node name for an actual file server. Click the node with the name 
File Servers.

3. In the right pane, click the Users tab.

4. In the table below the graphic, click the Delete ( ) button corresponding to the user you 
want to remove.

Exporting the List of Users
After you add your users, export the list of users in case you need to reinstall the management 
server. The user list is saved as a comma separated list (.csv file), which can be opened in a text 
editor, such as Notepad. You can add to the comma separated list as described in “Modifying a List 
of Users” on page 25.

To export the list of users:
1. Click AppExplorer.
2. Click File Servers node. 

Note: Do not click the node name for an actual file server. Click the node with the name 
File Servers.

3. In the right pane, click the Users tab.
4. Click the Export Users button.
5. When you are asked if you want to save the csv file, click Save. Then, designate a location 

to save the file.
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Modifying a List of Users
After you export a list of users, you can easily add to it. The attributes for each user appears on its 
own row. The format of a user’s record is as follows:

 <User ID>,<User Name>,<Home Directory(s)>,<Department>,
 <E- Mail>,<Quota><Owner(s)>

Assume you have a user with the following attributes:
User ID - JS
User Name - John Smith
Home Directory - Program Files
Department - Engineering
E-Mail - jsmith@companyname.com
Quota - 500
Owner -jsmith

The information for the user would appear as follows in the list:
JS,John Smith,\Program Files,Engineering,jsmith@companyname.com,500,jsmith

A list with multiple users would appear as follows:
JS,John Smith,\Program Files,Engineering,jsmith@companyname.com,500,jsmith

JD,John Doe,\Program Files,Engineering,jdoe@companyname.com,500,jdoe

DD,David Double,\Program Files,Engineering,jdouble@companyname.com,
500,ddouble

The record for a user with multiple home directories would appear as follows:
JS,John Smith,”\jsmith,\home\jsmith”,Engineering,
jsmith@companyname.com,500

The record for a user with multiple owners would appear as follows:
Adm,Administrator,,,netadmin@mycompany.com,,”root,bin,adm,uucp,nobody,
Administrator”

Note: The owner can be omitted if the home directory is provided, and the home directory can be 
omitted if the owner is provided.
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The following fields must be valid. Failure of any of these conditions causes the management server 
to log that record as an error and continue to the next record:

<User ID>
<Home Directory> Or <Owner>
<Department> - (Optional) If you provide a department, the department must exist on the 
management server. The department can be empty.
<Quota> - (Optional)
E-Mail - (Optional)

Table 2-1: Restrictions for User Fields

Field Condition
User ID Required field. Can’t include the following:

More than 64 characters
Single quote (')
Double quote (“)
Forward slash (/)
Back slash (\)

User Name Required field. Can’t include more than 64 
characters.

Home Directory Required if the owner is not specified.

List of one or more directories separated by 
commas, with each directory name not more 
than 4000 characters. 

Individual directory names should not contain 
commas.

Department Null or an existing department.
E-Mail Null or a string of up to 253 characters.
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Importing a List of Users
You can import a list of users from a csv file. For information on how to add to the current list of 
users in File SRM, see “Exporting the List of Users” on page 24 and “Modifying a List of Users” on 
page 25.

The management server provides two ways to import a list of users:
Full Import - Replaces all current users in the list with the users in the import file.
Partial Import - Updates existing users and adds new users.

To import a list of users:
1. Click File Servers node. 

Note: Do not click the node name for an actual file server. Click the node with the name 
File Servers.

2. In the right pane, click the Users tab.
3. Click the Import Users button.
4. Click the Browse button to select the list of users you want import.
5. Select Full Import or Partial Import. 

Quota (Megabytes) Null or 0 to indicate unlimited, or a rational 
decimal number less than 9999999999999. 

Value is in MBs.
Owner Required if the home directory is not specified.

List of one or more owner names separated by 
commas, with each individual owner name not 
exceeding 256 characters.

Individual owner names should not contain 
commas.

Table 2-1: Restrictions for User Fields (Continued)

Field Condition
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6. Click OK.
When you perform a partial or full import, you are provided with a report with the following 
information:

Number of records read
Number of users created
Number of users updated
Number of users failed to create
Format errors
Directory and owner both not specified
Directory already mapped to a user
Owner already mapped to a user
Invalid departments
Multiple entries for users

Viewing Information About Users on a Volume
You can view information about users on a volume, as follows:

1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.

Information about the volume is displayed.

3. Click the Users tab. 
Information about users on the volume is displayed.

4. Click a user.
The following information is displayed for the user:

File Server
Volume 
Size
Owner



CHAPTER 3 Individual File Server 
Details
This chapter describes the following:
Viewing Properties for a File Server on page 29
Finding Volume Details on page 31
Types of Files on a File Server on page 34
Aging Properties of Files on a File Server on page 36
Viewing Size Group Distribution Information on page 38
Viewing Events for a File Server on page 39
Viewing Policies for a File Server on page 41
Finding Individual Volume Details on page 41

Viewing Properties for a File Server
To view the properties for a file server:

1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.



Individual File Server Details30
4. Click a file server name in the tree.
5. Click the Properties tab in the right pane. 

The Properties page displays the following information.
Custom Name - A unique name for the file server. The custom name is displayed for the 
File Server SRM application instead of the file server's default name. The unique name 
helps in distinguishing this File Server SRM instance from the actual server. To create a 
unique name, type the name in the Custom Name field, and then click the Save button. 
*Vendor - The vendor that created the file server. 
Business Cost - Used to determine the cost impact of the application on the network. The 
currency displayed is dependent upon the standards and formats setting on the 
management server. In the Business Cost field, type an amount, for example 35.25. Then 
click OK.
Keep in mind the following:

You cannot enter a symbol in front of the number, except for the dollar sign ($).
You can enter a number with decimal points, 30.50.

*Contacted - The last time the software contacted the file server.
*Record Created - When a record was created for the file server. 
*Discovery Status - The status of the last discovery. If the element was just discovered, 
the status is at “created.” 
Install Date - When the file server was installed.
*Name Detected - The name of the file server detected.
OID - The Object Identifier
*Description - Provides information about the type of element. In this instance, it would 
display FileServer.
*Target Operating System - The operating system of the file server.
IdentificationCode - The identification code of the file server. 
*Product Name - The product name of the file server. 
Serial Number - The serial number of the file server.
Build Number - The build number of the file sever. 
Version - The version number of the file server.
*Host - The name of the host
Business Cost (per hour) - The business cost that was set at the top of this page. 

*These fields are populated. The rest of the fields are blank by default. 
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Finding Volume Details
To view the properties of the volumes on a file server: 

1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click the Volumes tab in the right pane. 

Note: You can view additional information on volumes that have had file server collection. See 
“Viewing Detailed Information for Scanned Volumes” on page 32 for more information.

This page displays the following: 
A graph displaying the top five volumes by usage on the file server. The amounts for free 
space and used space are displayed. Data less than 1 MB is not displayed in the graph. 
This could result in an empty graph if all data points are less than 1 MB.
A summary table to the right of the graph displaying the following:

Volumes - The number of volumes on the file server.
Capacity - The size of all volumes on the file server.
Used - The amount of used space on all volumes on the file server.
Free - The amount of free space on all volumes on the file server. 
Used Percent - The amount of used space on all volumes on the file server.
Free Percent - The amount of free space on all volumes on the file server.
Users - The number of users assigned to one or more of the volumes on the file 
server.
Users' Space - The amount of space the users use on the file server.

A table below the graph displaying the volumes and the following properties:
Capacity - The size of the volume. 
Used - The amount of space that is used on that volume. 
Used% - The percentage used on the volume.
Users - The number of users assigned to that volume. 
Users Space - The amount of space the users use.
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Viewing Detailed Information for Scanned Volumes
You can find even more information about a volume by clicking a volume that has had file server 
collection.

To access this information:
1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.

This page displays the following: 
A graph represented in one of the following ways:

If all large directories are less than 1 MB, the pie chart will have only two sectors 
(Free and Used).
If the volume has lot of large directories with a size larger than 1 MB, the pie chart will 
have one sector for Free, 8 sectors for the top 8 directories, and a last sector for Used 
(Rest).

A summary table to the right of the graph displaying the following:
Total Storage - The amount of total storage space on the volume.
Used - The amount of used space on the volume.
Free - The amount of free space on the volume.
Used Percent - The amount of used space on the volume.
Free Percent - The amount of free space on the volume.
File System - The type of file system on the volume.
No. of Files - The number of files on the volume.
No. of Directories - The number of directories on the volume.

Below the chart, there are three tabs which provide the following:
Largest Directories - This table lists the largest N directories on the volume, and the 
size of the directory, number of files in the directory, and number of subdirectories in 
the directory. The information in this table consists only of the files and directories 
directly contained in the directory in question and not those in the subdirectories. Click 
the hyperlink on the directory name to display a summary snapshot of the directory 
where the Aging, Extension, Size, Largest Files, and Aged Files information is 
presented in respective tabs. Click the hyperlinks in the tabs to download a list of the 
files satisfying the conditions. Click the Save All Files button to download a list of all 
the files in the directory. The downloaded file is in CSV format.
Largest Files - This table lists the largest N files on the volume. It displays the name 
of the file, its size, and the accessed, modified, and created time.
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Aged Files - This table lists the most aged N files on the volume based on the access 
time stamp. It displays the name of the file, its size, and the accessed, modified, and 
created time.

Note: The value of N in the above three tables is governed by the property 
fileSrm.countForFSRMDrilldowns.

Viewing Information About a Directory on a Volume
You can access the following detailed information about a directory on a volume:

Age tab - Displays the number of files and their size that have been accessed, modified, 
and created. 
Extension tab - Lists the file extensions by size and count.
Sizes tab - Lists the files by size.
Aged Files tab - Lists the file and the last date and time it was accessed, modified, or 
created. The date and time are based on the management server. 
Largest files tab - It lists the largest files first by size. The date and time the file was last 
accessed, modified or created is displayed.

To access this page:
1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.
3. Click the directory you want to find more information about.
4. If you want to save information about the files in this directory, click the Save All Files 

button.
The information is saved to a csv (comma separated list) file, which can be viewed in a text 
editor as well as Microsoft Excel. 

The following information is saved in the file:

file name
size
last accessed
last modified
when created
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Viewing File Count and Size for a Volume
You can view the number of files and the amount of space they occupy on a volume.

To access this information:
1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.

Information about the volume is displayed.

3. Click the Sizes tab. 
Information about the file count and size for a volume is displayed.

Viewing Information for a File Size Group
You can view the file size group details for a volume, as follows:

1. Click Configuration > FSRM.
2. Click the volume you want to find more information about.

Information about the volume is displayed.

3. Click the Sizes tab. 
Information about the file count and size for a volume is displayed.

4. Click a size group, for example 0-10 KB.
The files belonging to this size group are displayed, as well as information about them, 
such as their size, last access, last modified, and when created.

5. If you want to save this information, click the Save SizeGroup Details button.
The information is saved to a csv (comma separated list) file, which can be viewed in a text 
editor as well as Microsoft Excel. 

Types of Files on a File Server
The Extensions page provides information about the types of files on a file server. For example, it 
can let you know how many mpgs are stored on a file server and their file size. 

To access the Extension page:
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1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click the Extensions tab in the right pane. 

You see the following:

A graph displaying the top 10 extensions and their size. 
A table below the graph displaying the extension and its following properties:

Size - The size of all the files with that extension. This property lets you see 
which types of files are using the most space on a file server.
Count - The number of files with this extension.

6. To filter by extension, enter the extension name and click the Submit button
7. Click an extension in the Extension column in the table. 

The following is displayed:

A pie chart showing the sizes of the files with the extension per volume
A pie chart showing the number of files with the extension per volume
A table showing the number of files with the extension per volume and the amount of 
space they occupy.

Data less than 1 MB is not displayed in the graph. This could result in an empty graph if all 
data points are less than 1 MB.

8. To view a listing of the files with the extension on the volume, click a volume in the Volume 
column in the table. The largest N and most aged N files with the extension are listed in the 
tabs “Largest Files” and “Aged Files.” The filename with path, size, and the accessed, 
modified, and created time are provided.

Note: You can save the extensions for a volume in a comma-separated list (CSV file) by 
clicking the Save Extension Detail button in the right pane. 

Filtering Files

Filters use the following expressions:
d* will return all extensions starting with d 
*d will return all extensions ending with d 
*d* will return all extensions having d in the extension



Individual File Server Details36
You can enter a list of extensions separated by a comma. 

Aging Properties of Files on a File Server
To find information about the aging properties of the files on a file server: 

1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click the Aging tab in the right pane. 
6. To save the aging details to a comma-separated list (CSV file):

a. Click a link for a volume in the right pane.
b. Click one of the following headings in the right pane:

0-30 days
30-60 days
60-90 days
90-180 days
180+ days

c. Click the Save Aging Details button. 

By default the page displays the following information: 
A graph displaying the size of each set of files belonging to an age group: 

30 - Files accessed in the last 30 days
60 - Files accessed within 30 and 60 days
90 - Files accessed within 60 and 90 days
180 - Files accessed within 90 and 180 days
180+ - Files accessed more than 180 days ago.
Data less than 1 MB is not displayed in the graph. This could result in an empty graph 
if all data points are less than 1 MB.

A graph displaying the file count of files belonging to an age group: 
30 - Files accessed in the last 30 days
60 - Files accessed within 30 and 60 days
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90 - Files accessed within 60 and 90 days
180 - Files accessed within 90 and 180 days
180+ - Files accessed more than 180 days ago.
Data less than 1 MB is not displayed in the graph. This could result in an empty graph 
if all data points are less than 1 MB.

A table to the right of the graph displaying the number of:
Files (> 180 days) - The number of files accessed more than 180 days
Files Size (> 180 days) - The size of the files accessed more than 180 days ago.
Files (< 30 days) - The number of files less than 30 days old. 
Files Size (< 30 days) - The size of the files less than 30 days old. 

Age Distribution combo box. You can change this page to display information according 
to when the files were last modified or created. Select one of the options and click Submit.
A table under the graph displaying the number of files accessed within the specified time 
period and the size of those files.

To view aging properties for individual files, see “Viewing Aging Properties for Individual Files” on 
page 37.

Viewing Aging Properties for Individual Files
To view a listing of files with a particular age attribute, do the following:

1. Click the one of the following headings in the table on the Age tab for a file server.
0-30 days
30-60 days
60-90 days
90-180 days

The files that meet the criteria are listed.

2. Click a volume. The Largest N files that meet the criteria are listed.
3. To save the aging details to a comma-separated list (CSV file), click the Save Aging 

Details button. 
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Viewing Size Group Distribution 
Information
The Sizes tab displays size distribution information for file servers.

To access the Sizes tab:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Click the File Servers node.
4. Click a filer server name in the tree.
5. Click the Sizes tab in the right pane. 

The page displays the following:

A bar chart displaying the size group distribution by usage
A bar chart displaying the size group distribution by count
A table listing the number of files and the total size for each size group on each 
volume.

6. Click one of the following headings in the table on the Size tab:
0 Bytes 
0 -10 KB
10 -100 KB
100 -1 MB
1 -10 MB
10 - 100 MB
100 + MB

The following is displayed:

A pie chart showing the sizes of the files with the size group per server.
A pie chart showing the number of files with the size group per server.
A table showing the number of files with the size group per server and the amount of 
space they occupy.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty 
graph if all the data points are less than 1 MB. 
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7. To view a listing of the oldest N files with the size group on the volume, click a volume in the 
Drive column in the table. The value of N is governed by the property 
fileSrm.countForFSRMDrilldowns, which has a default value of 25 and is configurable in 
the range 10 to 100.

Note: You can save the files with the size group for a volume in a comma-separated list 
(CSV file) by clicking the Save SizeGroup Details button in the right pane.

Viewing Events for a File Server
The Events tab lists the events that involve the file server. It provides the following information about 
the events:

ID- The identification number assigned to the event
Severity - Provides the severity level
Time - The time the event was recorded.
Summary Text - A brief explanation of the event. When you click the summary text, the 
details of the event are displayed.

You can access the Events tab by doing the following:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click the Events tab in the right pane. 

Note: Events listed on this page may not be attributed to the correct source until Getting Details 
has completed.
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Viewing Event Details
To access event details, click the link for the event under the Summary Text column. You can also 
right-click an event and select Event Details from the drop down menu.

The Event Details pane provides information on one or more of the following:
Serial Number - The number assigned to the event
Summary Text - A brief explanation of the event
Element - It is the source of the event. An element can be a switch, host, application, fabric 
or anything else on the network. If this field is blank, the event did not come from an 
element.
Source - If the event came from an element, the name of the element is provided. 
Time Reported - The time the event was reported to the management server.
Probable Cause - Provides an explanation of a probable cause.
Recommended Actions - Provides recommendations.
Event Type - Provides a description of the event.
Correlated Indications - Information obtained from the provider.
Severity - Provides the severity level, which can be one of the following:

Clear
Unknown
Informational
Warning
Minor
Major
Critical

Journal Entries - Use this field to enter additional information and then click Add Journal 
Entry. This field is limited to 4,000 characters.

Sorting Events
To sort events, click the column title corresponding to the attribute you want to sort the event. For 
example if you want to sort events by time, click the Time heading on the table on the Events tab. 
The events are sorted by time on the Events page.
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Viewing Policies for a File Server
Policy Manager can automatically send an e-mail, generate an event, or run a custom script when 
the file server is being overused. For example, you can configure Policy Manager so you receive an 
e-mail message when the amount of free space on a file server decreases to a specified level.

Use the Policy tab to do the following:
Add Policies
Edit Policies
Test Policies
Delete Policies

You can access the Policies tab by doing the following:
1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click the Policies tab in the right pane. 

See “Policies for File Server SRM” on page 3 for more information.

Finding Individual Volume Details
To find volume details for a volume on a file server:

1. Click AppExplorer.
2. Expand the Applications node in the tree in Application Explorer. 
3. Expand the File Servers node.
4. Click a file server name in the tree.
5. Click a volume under the Volume column.

The File System Info tab opens in a new window. 

This page displays the following: 
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A graph represented in one of the following ways:
If all large directories are less than 1 MB, the pie chart will have only two sectors 
(Free and Used).
If the volume has lot of large directories with a size larger than 1 MB, the pie chart will 
have one sector for Free, 8 sectors for the top 8 directories, and a last sector for Used 
(Rest).

A summary table to the right of the graph displaying the following:
Capacity - The size of the volume
Used - The amount of used space on the volume
Free - The amount of free space on the volume 
Used Percentage - Percentage of used space on the volume 
Free Percentage - Percentage of free space on the volume 
File System - Type of the file system on the volume 
Number of Files - Total number of files on the volume 
Number of Directories - Total number of file on the volume

Below the chart, there are three tabs which provide the following:
Largest Directories - This table lists the largest N directories on the volume, and the 
size of the directory, number of files in the directory, and number of sub directories in 
the directory. The information in this table consists only of the files and directories 
directly contained in the directory in question and not those in the sub directories. 
Click the hyperlink on the directory name to display a summary snapshot of the 
directory where the Aging, Extension, Size, Largest Files, and Aged Files information 
is presented in respective tabs. Click the hyperlinks in the tabs to download a list of 
the files satisfying the conditions. Click the Save All Files button to download a list of 
all the files in the directory. The downloaded file is in CSV format.
Largest Files - This table lists the largest N files on the volume. It displays the name 
of the file, its size, and the accessed, modified, and created time.
Aged Files - This table lists the most aged N files on the volume based on the access 
time stamp. It displays the name of the file, its size, and the accessed, modified, and 
created time.

Note: The value of N in the above three tables is governed by the property 
fileSrm.countForFSRMDrilldowns.
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